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This document contains information about the Fiery EXP250 Color Server version 1.0. 
Before using the Fiery EXP250 Color Server with version 1.0, make copies of these 

 

Customer Release Notes

 

 and the 

 

Quick Connect Guide

 

 and distribute them to all users.
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This document uses the term “Fiery EXP250” to refer to the Fiery EXP250 
Color Server. The term “copier” is used to refer to the DocuColor 240/250 copier.

Before printing to the Fiery EXP250, make sure system software version 1.0 is installed 
on the Fiery EXP250. To determine this, print a copy of the Configuration page.
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1 In Command WorkStation, choose Print Pages from the Server menu.

2 Click Configuration.

3 Click Print.
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1 Make sure the information screen on the Control Panel reads Idle.

 

If Printing or RIPping appears, the Fiery EXP250 is processing, and you must wait until 
the system finishes and reaches the Idle state.

 

2 At the Control Panel, press the Menu button to access the Functions menu.

3 Select Print Pages.

4 Choose Configuration.
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1 Press the Machine Status button.

2 Touch the Billing Meter/Print Report tab on the touch screen.

3 Touch the Print Report/List option, and then the Network Controller Jobs Report option.

4 Select the System Setting List option.

5 Press the green Start button to print the Configuration page.

 

You must also install user software version 1.0 onto client computers. For instructions, 
see 

 

Printing from Windows

 

 and 

 

Printing from Mac OS

 

.

 

User 
documentation

 

User documentation available online

 

For user documentation in all supported languages, see the following web site:

 

http://services.efi.com/support/vfigs/9019710383/matrix.asp?pc=9927799780
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System software

 

After installing or upgrading software

 

After upgrading or reinstalling your system software, you must reboot the Fiery EXP250.

 

User Software CDs

 

Color files for Nordic languages

 

The User Software (Drivers) CD does not include the following color files for the Nordic 
languages (Norwegian, Finnish, Swedish, and Danish):

• CMYK Color Reference.ps

• PANTONE Book.ps

• RGB page 01.doc

• RGB page 02.ppt

• Custom21.ps

• Custom34.ps

• Standard21.ps

• Standard34.ps

 

Patch files for Job Log

 

The User Software (Utilities) CD contains two patch files in the Mixed Media Job Log 
Patches folder. These patches allow you to enable and disable a feature in Job Log that displays 
media information for Mixed Media jobs. To install either patch, download the PostScript file 
to the Fiery EXP250 Print queue. The file is processed, but no output is printed.

 

Setup

 

SNMP Community Names Verification

 

If the SNMP Community Names Verification window appears when you try to start 
WebSetup, make sure that the Fiery EXP250 and the copier are both on and correctly 
connected.

 

Control Panel Maps

 

The Control Panel Maps are printed in English regardless of the language installed on 
the server.

 

Fiery EXP250 device name

 

For both DocuColor 250 and DocuColor 240 copiers, the Fiery EXP250 device name is 
DC250. In the Configuration page and other Fiery EXP250 pages, DC250 refers to the 
device name, which applies to both products.
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Changing the time in WebSetup

 

When you change the time and date using the DocuColor 240/250 tools mode, the change 
applies to the copier only, not the Fiery EXP250. To change the time and date on the 
Fiery EXP250, use WebSetup. The time on the Fiery EXP250 is shown in the header of 
reports such as the Job Log and Configuration page. 

 

Changing the time zone

 

If you change the Time Zone setting in Fiery Setup (from FieryBar), the Configuration page is 
not updated with the new setting. If you change the Time Zone setting on the Fiery EXP250 
Control Panel, the Configuration page shows the new setting. However, you must manually 
set the time to the current time in the new time zone.

 

Cannot disable Web Services

 

You cannot disable Web Services in WebSetup, because there is no way to re-enable Web 
Services. If you deselect the option and reboot the Fiery EXP250, the option is once again 
selected when you view it.

 

Accessing WebSetup

 

If you are unable to access WebSetup by typing the DNS name of the Fiery EXP250 in 
Internet Explorer, perform the following steps:

 

1 Start WebSetup by typing the IP address of the Fiery EXP250 in Internet Explorer.

 

The Accessing WebSetup window appears, displaying instructions for configuring 
Internet Explorer.

 

2 Follow the on-screen instructions. 

 

If the Java Custom Settings button is not visible, scroll to the Microsoft VM area of the 
Custom Level dialog box and select Custom under Java Permissions.

 

3 Repeat the instructions, but select the Local Intranet zone, instead of Internet. Configure 
the Local Intranet options using the same settings that were used for the Internet zone.

 

FTP Proxy Setup

 

To use the FTP Proxy service, you must first enable FTP Services.

 

Printing from Tray 5 (Bypass Tray) by default

 

To set a default for jobs to use the Bypass Tray, specify the tray at print time in the printer 
driver. There is no Setup option by which the administrator can set a default. 

 

WINS Address

 

The WINS Address does not appear in WebSetup in DHCP mode when you configure 
Network Setup. Print a Configuration page to see the WINS address.
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LDAP Server Setup

 

If you enable an LDAP Server (in More Setup), you must also meet the following 
requirements:

• Make sure the LDAP Server IP address and host name are registered on the DNS server 
and that DNS Setup is enabled on the Fiery EXP250. To enable DNS Setup, select 
Enable DNS Setup on the Protocol2 tab under Network Setup.

• You must enable the Fiery EXP250 e-mail service (on the Service3 tab under Network 
Setup) to allow LDAP to access corporate e-mail addresses from Remote Scan. 

• In a Windows Server 2003 Active Directory DNS environment, add the Fiery EXP250 to 
the Windows Active Directory Domain. Otherwise, the LDAP feature might not be able 
to resolve the LDAP Server name. The Windows domain setting is on Service 2 tab of 
Network Setup.

• Make sure the time difference between the LDAP Server and the System Time of the 
Fiery EXP250 is 5 minutes or less. Set the time on the Fiery EXP250 using WebSetup.

 

WebSetup on Mac OS X

 

To use WebTools on Mac OS X, set the display resolution to 1280

 

>

 

1040 or higher. 
Otherwise, some options in WebSetup may be hidden.

 

Error History Report

 

The Error History Report shows the error “027-741 Job Template Server Connect Fail” each 
time the Fiery EXP250 is rebooted. This message is triggered as part of the normal start-up 
sequence and does not indicate an error condition.

 

Member Printing (Printing Groups)

 

If Member Printing is enabled, you cannot download files from Downloader, 
WebDownloader, or Command WorkStation, or using FTP Printing. If Member Printing 
is enabled, do one of the following:

• Print directly from the application in which the file was created.

• Download the file to the Hold queue, change the owner information for the job with 
Command WorkStation, and send the job to print.

• You can print via FTP if you set the group name and password to the same values used 
to authenticate the FTP session.
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Disabling TCP/IP does not update dependent options

 

If you disable the TCP/IP protocol, other options that depend on TCP/IP (such as Scan to 
FTP) are not automatically disabled. You must disable them manually.

If the TCP/IP protocol is disabled, you are prompted to enable TCP/IP before you can access 
the following areas under Protocol Setup:

• DNS Setup

• Security Setup

or the following services under Service Setup:

• LPD Setup

• Windows Setup

• Web Services Setup

• IPP Setup

• Port 9100 Setup

• E-mail Setup

• FTP Setup

• SNMP Setup

• LDAP Setup

 

SNMP limitations

 

If you change the community name or disable SNMP, WebSetup does not work. 
Power the copier off, then on when you make a change to the SNMP tab in More Setup.

If you disable SNMP, the automatic search for the Fiery feature in Command WorkStation, 
which is based on SNMP, does not work.

If you disable SNMP, the following features are affected:

• Two-Way communication

• All Fiery EXP250 applications that search for Fiery EXP250 controllers using SNMP 
(Command WorkStation, Remote Scan, and Downloader)

• Xerox CentreWare

• Xerox MIBs
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Login Window for SNMP

 

After you change and save the community name, a Login window appears. To validate the 
changes, type “Admin” as the User Name and the Administrator password in Command 
WorkStation as the Password.

 

Garbled diagnostic message (Brazilian Portuguese)

 

In the Brazilian Portuguese server, if you right-click the FieryBar and choose 
Run Diagnostics >Test I/F board, the message that appears is garbled.

 

Network

 

Ethernet speed

 

The Ethernet speed setting under Network Setup on the copier control panel lists two choices 
that are not supported: 10BASE-TX (Full Duplex) and 100BASE-TX (Full Duplex). It does 
not list a choice for a 1-Gbit speed. Use WebSetup to set the speed to 1 Gbit.

 

NDS Setup

 

In Network Setup, to enable both PServer Mode and NDS, first select the Enable PServer 
Mode option, and then wait until the cursor returns to an idle state before you select the 
Enable NDS option.

 

IPX Frame type

 

In WebSetup, under Network Setup, you can select multiple IPX Frame types. However, 
Network Setup on the copier control panel allows you to select only one IPX Frame type. 
If you have selected multiple types through WebSetup, only one is shown in the copier 
control panel.

 

Changing network settings

 

If you change any network settings in Setup from the copier control panel, the Fiery EXP250 
reboots. The Fiery EXP250 loses connection with the copier until it has finished restarting, 
which takes a minute or two. To determine whether the connection has been restored, press 
the All Services button. If the Network Scanning button appears dimmed, the connection has 
not been restored.

 

Maximum number of users for SMB

 

The Fiery EXP250 supports a total of eight simultaneous SMB connections, including the 
Direct connection, Print queue, and Hold queue.

 

Windows 2000 and LPR availability

 

When you perform a clean installation of Windows 2000 on a client computer, no LPR 
services are available by default. Your only option is to print through a standard TCP/IP 
port, or use SMB printing. However, if you converted a Windows NT 4.0 computer to 
Windows 2000, LPR printing services are retained.
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Creating an SMB port in Windows 2000/XP

 

To create an SMB port in Windows 2000/XP, you must first establish a connection to the 
Fiery EXP250 by its IP address. Choose Start and select Run. At the prompt, enter “\\” 
followed by the Fiery EXP250 IP address, and then click OK. After you make the connection, 
follow the instructions to create an SMB port on Windows 2000/XP.

 

Banner Page on NetWare networks

 

We recommend that you disable the NetWare banner page. Instead, configure the 
Fiery EXP250 in Setup to use the Cover Page with each job.

 

User name on Cover Page from Netware 

 

The Cover Page displays the complete NetWare context for the user name. 

 

Printer drivers

 

Configuring the Windows printer drivers

 

To use the printer driver on Windows 2000/XP/Server 2003, you must first configure 
the options in the Advanced tab of the printer driver after installation is complete. 

 

T

 

O

 

 

 

CONFIGURE

 

 

 

THE

 

 

 

OPTIONS

 

 

 

IN

 

 

 

THE

 

 A

 

DVANCED

 

 

 

TAB

 

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printer and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Click the Fiery EXP250 icon and choose Properties from the File menu.

3 Click the Advanced tab.

4 Select the following options:

 

• Spool print documents.

• Start printing immediately.

• Print spooled documents first.

 

5 Deselect the following option:

 

• Enable advanced printing features.

 

6 Click Apply to save your changes.

7 Click OK.
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Duplicate Page Size settings

 

In the Windows 2000/XP/Server 2003 printer driver, the Page Size option lists the following 
redundant (duplicated) settings. 

• Letter and 8.5

 

x

 

11 LEF

• Legal and 8.5

 

x

 

14 SEF

• Tabloid and 11

 

x

 

17 SEF 

• A3 and A3 SEF

• A4 and A4 LEF

• A5 and A5 LEF

• 9

 

x

 

11 and 9

 

x

 

11 LEF

 

Duplicate Paper Source settings

 

In the Mac OS X printer driver, there are two Auto Select settings displayed for the Paper 
Source option. Choose the second one in the list.

 

Incorrect information in Windows PostScript driver

 

In the Windows PostScript driver Properties window, in the Features area of the General tab, 
“No” is listed next to Double-sided. However, double-sided (duplex) printing is supported.

 

Mac OS X and Use Media Defined Profile

 

On Mac OS X, to set the Output Profile option to Use Media Defined Profile, you 
must first make sure Two-Way Communication is not enabled, and then you can select 
Use Media Defined Profile from the drop-down list for Output Profile. Enable Two-Way 
Communication to be able to select specific downloaded output profiles.

 

Mac OS X v10.4 support

 

The OS X Installer, PPD, and PPD plug-ins are all supported by Mac OS X v10.4.
If you experience difficulty installing the printer driver on Mac OS X v10.4, contact 
Technical Support.

 

Printer image

 

The printer image in the printer driver does not display properly if it is viewed in 24-bit 
screen resolution. To display the image properly, change the screen setting to 16-bit or 
32-bit resolution.

 

Member Printing and Saved Settings

 

In the Windows printer drivers, if you save a collection of settings that include Member 
Printing information (such as a printing group name and password), assign the Saved Settings 
a name. Do not leave the Saved Settings as “Untitled.”
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Entering an IP address

 

In the Properties dialog box, pressing Enter after you type an IP address closes the dialog box. 
Press Tab or use the mouse to move between fields and fill in all options before you press 
Enter or click OK.

 

Image Shift on Mac OS X

 

In the Mac OS X printer driver, the Image Shift X and Y fields may display a value of -0.00 
if the units of measurement are inches or millimeters. This value is the same as 0.00.

 

Custom page size maximum values (Windows)

 

When you enter a custom page size in the Windows printer driver, the maximum values 
shown are slightly different from the maximum values shown when you enter a custom page 
size in Command WorkStation. The values shown in Command WorkStation are correct. 
If you enter an invalid value in the printer driver, it automatically corrects the value. 
If you enter an invalid value in Command WorkStation, it displays an error message.

 

Installed options not shown (Windows)

 

The graphic of the printer shown in the Windows PostScript printer driver does not show the 
configuration of installed options unless you open the Accessories tab of the printer driver 
Properties window, enable Two-Way Communication with a valid IP address, click Update, 
and click OK.

 

Two-Way Communication (Windows)

 

If you create and set up a new printer port when you install the Windows PostScript 
or PCL printer driver, the printer driver is automatically configured with Two-Way 
Communication enabled. The Update Fiery Driver When Opened option is also 
selected automatically.

 

Printing

 

Job status information

 

When you make photocopies on the copier, information about the job is displayed. 
The same kinds of information, however, are not displayed while the Fiery EXP250 is 
printing a job. To determine information about a job sent to the Fiery EXP250, print the 
Job Log, or view the job with the job management tools (Command WorkStation and 
Spooler).

 

Out-of-paper message when Paper Source set to AutoSelect

 

If you set the Paper Source option to AutoSelect, the Fiery EXP250 selects the tray to print 
from according to its priority list. If a tray runs out of paper in the middle of a job, the 
Fiery EXP250 requests that you load paper in the first tray on its priority list, but you can 
load paper in any tray that supports the required paper size.
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No out-of-toner message on copier while printing

If toner must be replaced while a job is printing, a message appears in Command 
WorkStation, but the copier does not display a message until it is finished printing. 
You can replace toner while the copier is printing.

Incomplete printout with I/O error

When you print from a Windows PostScript driver, if your job does not finish and an Error 
page prints that indicates ioerror, try reprinting the job with the PostScript output format set 
to PostScript (optimized for portability - ADSC) rather than PostScript (optimized for speed). 

TO SET THE POSTSCRIPT OUTPUT FORMAT

1 Print the job from the application, select the Fiery EXP250 as the printer, and click 
Properties. 

2 Click the PostScript tab.

3 Choose PostScript (optimized for portability - ADSC) under PostScript Output Format. 

In this format, each page of the document is sent as a self-contained, independent page 
description.

Novell systems

If you print a job with Novell, the PCL Separator Page does not work.

Suspend Printing message

If you suspend printing, Command WorkStation and the Fiery EXP250 do not display the 
copier as offline immediately. The printer offline message is not displayed until the copier 
finishes printing that portion of the job.

Date and time stamps for jobs

You can print these reports:

• Job Status

• Scan Mode Settings

• Copy Mode Settings

• Network Controller Jobs Report

All jobs in Job Status, Scan Mode Settings, and Copy Mode Settings use the date and time on 
the copier.
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Reports you can print from Network Controller Jobs Report include:

• Job History Report

• Error History Report

• Fonts List

• System Settings List

The Job History Report, Fonts List, and System Settings List use the date and time on the 
Fiery EXP250. The Error History Report uses the date and time on the copier (except for 
error codes from the Fiery EXP250).

Entering Secure Print password

If you enter a Secure Print password in the Fiery EXP250 Control Panel that exceeds the 
maximum password length, the cursor returns to the beginning of the line. You can overwrite 
and delete characters at the cursor’s position, but you cannot move the cursor forward to 
delete characters that are beyond the cursor’s position. As a workaround, you can retype 
the characters that you already entered (overwriting the existing characters with the same 
characters) until you reach the character that you want to delete.

Printing PDF with mixed page sizes

If you print a PDF document that contains mixed page sizes using the PostScript printer 
driver, all pages are printed to the default page size on the Fiery EXP250. If you print the 
same PDF document through Hot Folders, the job prints correctly.

Job batching

If job batching is enabled, multiple jobs received by the Fiery EXP250 close together are 
printed as a single job. You can control job batching through the Job Batching Delay option 
under More Setup in WebTools. If this option is set to 0, job batching is disabled. If this 
option is set to a nonzero value, jobs that are received within this number of seconds are 
batched.

If job batching is enabled:

• The job information displayed on the copier for batched jobs is not correct, because the 
jobs are considered one job. Command WorkStation and the Job Log show the correct 
information for the individual jobs.

• After printing is complete, the job status remains Printing until the Job Batching 
Delay expires.

• Color jobs are not batched with grayscale or black-and-white jobs.

• Jobs with the Save Fast Reprint option selected and jobs printed through the Print and 
Hold command in Command WorkStation are not batched. They are always printed as 
individual jobs.
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Saving as a PDF or PostScript file in Mac OS X

On Mac OS X, if you set Image Shift with duplex settings, save the document to a PDF or 
PostScript file, and then print the file, the job prints single-sided without the Image Shift 
settings. If you print the document with the same settings directly, without saving the file 
to PDF or PostScript, the job prints correctly.

Printing delay on Windows 2000/XP

With Windows 2000 and Windows XP, all MS-DOS printing is done through the Windows 
NT spooler system. In order to know when to send a job to the spooler, there is a timeout 
on the printer port. Once a job has been printed to the port, if this timeout passes with no 
more data presented to the port, the print job is sent to the spooler. The default timeout 
is 15 seconds. Therefore, there is a 15-second delay before the print job starts printing. 
Microsoft has documented this issue in the following web page:

http://support.microsoft.com/default.aspx?id=kb;en-us;Q101850

A computer using any version of Windows 2000 or Windows XP (including the Windows 
2000 data server) requires the following changes. If you use Citrix or terminal services, the 
changes must also be implemented on the Windows 2000 server running Citrix/Terminal 
Services, as well as each workstation that uses the Windows 2000 or Windows XP 
operating system. 

To decrease the timeout, use the following procedure to edit these registry settings:

• HKEY_LOCAL_MACHINE

• SYSTEM 

• CurrentControlSet

• Control

• WOW

• LPT_Timeout

WARNING: Using REGEDT32 can cause serious damage to your operating system. 
Make sure to follow these steps exactly.

TO DECREASE PRINTING DELAY DUE TO TIMEOUT

1 On the Windows 2000 or Windows XP computer where the printer is connected, 
choose Start > Run and type REGEDT32.

2 Bring up HKEY_LOCAL_MACHINE.

3 In the header, click View and make sure to select “Tree and data”.
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4 In the left pane, expand System >CurrentControlSet >Control >WOW.

5 In the right pane, double-click LPT_timeout. 

6 A prompt for a string with a default of 15 (seconds) appears. Change the string to 3, 
and then click OK. 

7 Close RegEDT32.

8 To test whether the local printer now prints faster, print any large document. 

9 Repeat these steps for every computer running any version of Windows 2000 or Windows XP, 
including the data server, Citrix/Terminal Server, and all remote workstations connected via 
Citrix/Terminal Services. 

Booklet printing Printing a booklet from Microsoft Word on Windows (PostScript printer driver)

Booklet printing requires that a finisher is installed on the copier and that the printer driver is 
configured with the installed finisher. For information about configuring installable options, 
see Printing from Windows.

The following procedure explains how to set the correct print options for printing an 8.5x11 
Microsoft Word document as a booklet on 11x17 paper, or for printing an A4 document 
as a booklet on A3 paper, using the Windows PostScript or PCL printer driver.

NOTE: If you print multiple copies of a booklet, make sure the Collate option in Microsoft 
Word is cleared. Otherwise, all the copies will print as one booklet.

TO PRINT A BOOKLET FROM MICROSOFT WORD USING THE WINDOWS POSTSCRIPT PRINTER DRIVER

1 Open the document in Microsoft Word.

2 Select File >Page Setup.

3 Set the Paper Size to 8.5x11 SEF (A4 SEF) and Orientation to Portrait.

NOTE: This step may change the appearance of the text on the page.

4 Select File>Print, choose the Fiery EXP250 as your printer, and then click Properties. 

5 In the Fiery Printing tab, open the Paper Source bar and choose the following settings:

Page Size: 8.5x11 SEF (A4 SEF)

Print Size: 11x17 SEF (A3 SEF)

6 Open the Layout bar and choose the following setting:

Orientation: Portrait
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7 Open the Finishing bar and choose the following settings:

Duplex: Top-Top

Face-down Printing: Face Up

Fasten Mode: Fold or Fold and Staple

NOTE: For the limitations on folding and stapling, see “Fasten Mode” on page 17.

Output Tray: Booklet Output Tray

Booklet Maker: Saddle

Booklet Best Fit: Select this option

8 Optionally, set one or more of the following options under the Finishing bar:

• Creep Adjustment 

• Centering Adjustment

• Back Cover 

• Front Cover 

• Cover Source 

9 Click OK to close the Properties window.

10 Set the number of copies. 

11 Click OK to submit the job for printing.

Printing a PDF document as a booklet on Windows (PCL printer driver)

Booklet printing requires that a finisher is installed on the copier and that the printer driver is 
configured with the installed finisher. For information about configuring installable options, 
see Printing from Windows.

The following procedure explains how to set the correct print options for printing an 8.5x11 
PDF document as a booklet on 11x17 paper, or for printing an A4 document as a booklet on 
A3 paper, using the Windows PCL printer driver.

TO PRINT A PDF DOCUMENT AS A BOOKLET USING THE WINDOWS PCL PRINTER DRIVER

1 Open the document in Adobe Acrobat or Acrobat Reader.

2 Select File > Print Setup.

3 Set the Paper Size to 11x17 SEF (A3 SEF).

4 Select File>Print, choose the Fiery EXP250 as your printer, and then click Properties. 
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5 On the Fiery Printing tab, open the Paper Source bar and choose the following setting:

Page Size: 11x17 SEF (A3 SEF)

6 Open the Layout bar and choose the following setting:

Orientation: Portrait

7 Open the Finishing bar and choose the following settings:

Duplex: Top-Top

Face-down Printing: Face Down

Fasten Mode: Fold or Fold and Staple

NOTE: For the limitations on folding and stapling, see “Fasten Mode” on page 17.

Output Tray: Booklet Output Tray

Booklet Maker: Saddle

Booklet Best Fit: Select this option

8 Optionally, set one or more of the following options under the Finishing bar:

• Creep Adjustment 

• Back Cover 

• Front Cover 

• Cover Source 

9 Click OK to close the Properties window.

10 Set the number of copies. 

11 Click OK to submit the job for printing.

Printing a booklet from Mac OS X v10.4

On Mac OS X v10.4, the printer driver constrains some selections if an incompatible setting 
is selected. For example, you cannot select any Booklet Maker settings unless you first set the 
Duplex option to Top-Top. 

Booklet printing requires that a finisher is installed on the copier and that the printer driver is 
configured with the installed finisher. For information about configuring installable options, 
see Printing from Mac OS.

The following procedure explains how to set the correct print options for printing an 8.5x11 
document as a booklet on 11x17 paper, or for printing an A4 document as a booklet on A3 
paper, using the Mac OS X v10.4 printer driver.
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TO PRINT A BOOKLET FROM MAC OS X V10.4

1 Open the document in the application.

2 Select File > Page Setup.

3 Choose the Fiery EXP250 as your printer, set the Paper Size to 8.5x11 SEF (A4 SEF), and then 
click OK.

4 Select File >Print.

5 Choose the Fiery EXP250 as your printer and choose Printer Features from the drop-down list. 

6 Choose Paper Source 2 from the Feature Sets list.

7 Set Print Size to 11x17 SEF (A3 SEF).

8 Choose Finishing 1 from the Feature Sets list.

9 Set Duplex to Top-Top.

10 Choose Finishing 2 from the Feature Sets list.

11 Set Fasten Mode to Fold or Fold and Staple.

For the limitations on folding and stapling, see “Fasten Mode” on page 17.

12 Choose Finishing 4 from the Feature Sets list.

13 Set Face-Down Printing to Face up.

14 Choose Finishing 1 from the Feature Sets list.

15 Set Booklet Maker to Saddle.

16 Choose Finishing 3 from the Feature Sets list.

17 Select the Booklet Best Fit option.

18 Optionally, set one or more of the following options:

• Creep Adjustment (under Finishing 3)

• Centering Adjustment (under Finishing 2)

• Back Cover (under Finishing 2)

• Front Cover (under Finishing 2)

• Cover Source (under Finishing 2)

19 Click Print to submit the job for printing.



Page 17

Part Number: 45048062

Fasten Mode

For a folded and stapled booklet, the maximum number of sheets is 15 (a 60-page booklet). 
For a folded, unstapled booklet, the maximum number of sheets is 5 (a 20-page booklet). 
If your booklet is larger than 60 pages and you choose folding and stapling, the finisher will 
not staple it. The booklet is output in multiple sets of 5 folded sheets.

Centering Adjustment and Creep Adjustment and booklet printing

The Centering Adjustment and Creep Adjustment options apply only to booklet printing. 
You must set the Booklet Maker option before you can set these options.

Booklet cover single-sided if job is single-sided

If Duplex is Off, the cover cannot be printed on the back side, even if you set Front Cover 
or Back Cover to Print on Back or Print on Both. The cover is not printed duplex if the job 
is single-sided.

Booklet Output Tray and Cover Page

If you print a job to the Booklet Output Tray, the job does not print with a cover page, 
regardless of the Cover Page setting.

Cannot print secure PDF file as booklet (PostScript printer driver)

If a PDF file requires a password to edit, printing it as a booklet from the PostScript printer 
driver results in an error. Print from the Windows PCL printer driver instead.

Landscape PDF booklet job

If you print a landscape-oriented PDF job and set the Booklet Maker option in Command 
WorkStation Job Properties, the pages are printed Top-Bottom instead of Top-Top, and the 
pages are in reverse order. Instead, set the Booklet Maker option in the printer driver when 
you send the job to the Fiery EXP250, and the booklet prints correctly.

No booklet printing from Mac OS printer driver

The Booklet Maker option and other options related to booklet printing (Cover Source, 
Front Cover, Back Cover, Fasten Mode, Centering Adjustment, Creep Adjustment and 
Booklet Best Fit) are not available on the Mac OS 9 printer driver. You can print from 
Mac OS 9 to the Hold queue and use Command WorkStation to set the Booklet Maker 
options.
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E-mail printing SMTP services

You must enable SMTP services on your network’s e-mail server.

E-mail account password

E-mail printing does not work if the Fiery EXP250 e-mail account does not have a password. 
To receive e-mail print jobs, you must set a password for the e-mail account that the 
Fiery EXP250 is configured to use.

Supported file attachments

The supported file attachments for e-mail printing are PostScript, PRN (Windows printer 
file), PDF (version 1.5), and TIFF (version 6).

JPEG and Microsoft Office documents are not supported as attachments. 

TIFF documents

If you print a TIFF file through e-mail by attaching the file to an e-mail message sent to 
the Fiery EXP250, and the TIFF file was compressed using G3MH or G4MMR, the file is 
printed correctly but no e-mail notifications are sent.

When you send a TIFF document to the Fiery EXP250 as an e-mail attachment, no cover 
page is printed.

Scan to e-mail printing

By combining the Scan-to-E-mail and Print-by-E-mail features, you can send a scan directly 
to the Fiery EXP250 to be printed, if the scan file format is TIFF or PDF. If the scan file 
format is JPEG, you cannot print it by e-mail, since JPEG is not a supported format for 
this feature.

No e-mail printing if Printing Groups enabled

If Printing Groups are enabled, printing via e-mail is disabled because the group name and 
password cannot be entered via e-mail. E-mails received by the Fiery EXP250 are returned to 
the sender.

WebSetup allows you only to enable or disable the use of Printing Groups. To define the 
actual groups, use Command WorkStation. 
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Print options Image Shift not available from applications

The print options related to Image Shift are not available in the Print dialog of the application 
you print from. You must set these options in the Fiery Printing tab.

Printer Screen Mode and color objects

If you set the Printer Screen Mode option to Enhanced Text & Graphics or Enhanced Text, 
you might see a color difference between text, graphics, and image objects. If this occurs, set 
the Printer Screen Mode option to 200 Cluster Dot or 200 Rotated Line.

Black Overprint and uneven color

If you use the default setting for the Black Overprint option, which is Text/Graphics, you 
might see uneven color in some jobs. If this occurs, set the Black Overprint option to Off.

CMYK Simulation Method and color gradation

If you find that color gradations are not printed smoothly, try setting the CMYK Simulation 
Method to Full (Source GCR).

Output Profile and black objects

If you print using the default setting for Output Profile, black objects can be printed using 
color toner. If you prefer to print black objects using only black toner, set the Output Profile 
to Fiery EXP250 DC250 100GCR v1F. You must enable Two-Way Communication to see 
the actual names of the output profiles.

Combine Separations

If you select the Combine Separations option, the job is printed single-sided and face down, 
regardless of how the Duplex and Face-Down Printing options are set.

Layout option and line widths

If you print with the Layout option set to any setting besides 1-up, some line widths may vary.

Print options not supported on Direct connection

The following print options are not supported when printing to the Direct connection, only 
when printing to the Print queue or Hold queue: Collate, Booklet Maker, Fasten Mode, Print 
Size, Stapler Mode, Face-Down Printing, Create Master, Use Master, Print Master, Remove 
White PPT Background. 

The Save Fast Reprint option is supported only when printing to the Print queue.
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Manual Duplex

To print with the Manual Duplex option using Tray 5 (Bypass), first print all the odd-
numbered pages single-sided. Then a message appears in Command WorkStation (and on the 
Fiery EXP250 Control Panel and copier display) asking you to “place odd sheets in Tray 5.” 
Load the printed odd-numbered pages into Tray 5 (after first removing any blank sheets) to 
print the even-numbered pages on the blank sides. For more details about how to orient the 
pages, see Print Options.

NOTE: The message displayed at the copier does not specify that you must load the odd-
numbered sheets to print side 2. See the message displayed in Command WorkStation 
or Job Monitor instead. 

Mixed Media and collation

To collate a job when you print using Mixed Media settings, do not set the Collate option 
in the Print dialog box. Instead, set the Collate option in the Fiery Printing tab.

Mixed Media, Duplex, and Orientation

For a Mixed Media job in which some pages are oriented Portrait and others are oriented 
Landscape, duplex pages might not print with the correct orientation. 

Media Type selections dimmed (Windows)

In the Windows printer drivers, a Media Type setting appears dimmed if there are other print 
options selected that would be in conflict with that Media Type setting. You can still select a 
dimmed setting, and you can have the printer driver resolve the conflict automatically.

Face-Down Printing and Stapler Mode

Face-up output is not compatible with stapling. If you set Face-Down Printing to Face Up, 
you cannot select any Stapler Mode setting except Off.

Face-Down Printing and custom page size

If you print to a custom page size and set the Face-Down Printing option to Face Down, the 
page dimensions must be within the following ranges, otherwise the job is printed Face Up:

• Width: 139.7 to 330 mm

• Length: 182 to 488 mm

Paper size

When you send a job from an application that allows you to specify paper size in the 
Print dialog box (such as Microsoft Word), select the same paper size in both the application’s 
Page Setup dialog box and the printer’s Properties dialog box.

Before printing your job, verify that the paper size selection in Document Setup and 
Page Setup are the same. This will resolve problems with the printed output, such as 
image clipping and unintentional scaling.
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Custom page size

When you specify a custom page size in the Windows printer drivers, make sure that the 
custom size matches the page size specified in your application. If the page sizes do not match, 
the custom page size may not print correctly.

You can print to a custom page size from Tray 1, Tray 2, or Tray 5 (Bypass). For Tray 1 
or Tray 2, set the page dimensions at the copier in Setup > Paper Tray Attributes. If the 
document you must print has a page size of 220 x 297 mm, for example, set x=220 and 
y=297. For Tray 5 (Bypass), load the paper so that the short end of the page feeds into the 
copier. Note that the message that prompts you to load paper has the dimensions reversed 
(297 x 220 instead of 220 x 297). 

All custom page sizes sent to the copier must be created SEF (Short Edge Feed). 

Paper Source set to Auto Select

If you print a job with Auto Select as the paper source, the copier uses any of the Trays 1- 4, 
or Tray 6. It does not use Tray 5, which is the Bypass Tray.

Printing from Tray 5 disregards media settings of job

If you print a job with Tray 5 (Bypass) as the paper source, the job is printed on the paper 
loaded in Tray 5, even if the paper does not match the job’s settings for page size, media type, 
and media quality. However, the copier prints the job according to the job’s settings, not the 
actual paper used. Be sure to load paper that matches the job’s settings.

Page Range

You cannot access the Page Range option from the printer driver. Use the application page 
range option or change the setting for this option from Command WorkStation or Spooler.

Watermarks, Negative Image, and Print Page Borders

The Negative Image print option is not available in Windows printer drivers. The 
Watermarks and Print Page Borders print options are not available in the Windows 
PostScript printer drivers.

These print options are available under Page Setup in Mac OS 9 and Mac OS X Classic.

Layout and Print Page Borders

If you print an N-up job, where N is greater than 1, from the PCL printer driver, you can 
control whether the borders of the pages are printed through the Print Page Borders option. 
If you print from the PostScript printer driver, page borders are always printed.

Default page size

If the Fiery EXP250 and the copier have different settings for default page size, the 
Fiery EXP250 uses the default page size setting of the copier.
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Custom page size with Tray 1 or Tray 2

If you print to a custom page size that is larger than the maximum page size for Tray 1 or Tray 
2, you can still select Tray 1 or Tray 2 as the Paper Source for the job. However, when you 
print the job, the paper source is changed to Tray 5 (Bypass) automatically.

Orientation, Layout and Duplex (Mac OS)

On Mac OS X and Mac OS 9, if you print a duplex job with Orientation set to Portrait and 
Layout set to 2-up or 6-up, you must also set the Orientation Override option to Landscape 
to obtain the correct duplex output (Top-Top). If Orientation is set to Landscape instead of 
Portrait, set Orientation Override to Portrait.

Print options not supported for variable data, imposed jobs

For variable data jobs that are imposed, do not use the following print options (the first two 
are part of the Graphic Arts Package, Premium Edition): Postflight, Control Bar, or Paper 
Simulation.

Mixed Media Page Range

In Mixed Media settings, the largest value you can enter for Page Range is 999999.

Stapler Mode and Punch Position

Stapling and punching require that a finisher is installed on the copier. The finisher type 
determines the number of holes (2, 3, or 4) punched. 

Use the Punch Position print option to specify the position of punching. Use the Stapler 
Mode print option to specify the number (1 or 2) and position of staples. 

Neither stapling nor punching are supported for the following page sizes:

4x6 SEF, 5x7 SEF, A5 SEF, A5 LEF, B5 SEF, 12x18 SEF, SRA3 SEF, 13x19 SEF
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To see which stapling and punching options are available for each supported page size, 
see the following tables.

For no Hole Punch (Punch Position set to None):

S = Stapling supported
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S S - -

A4 SEF - S S S S - - S S

A4 LEF - S S S S S S - -

Letter SEF - S S S S - - S S

Letter LEF - S S S S S S - -

8.5x13 SEF - S S S S - - S S

Legal SEF - S S S S - - S S

B4 SEF - S S S S - - S S

A3 SEF - S S S S - - S S

11x17 SEF - S S S S - - S S

Letter 
Cover LEF

- S S S S S S - -

A4 Cover LEF - S S S S S S - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S S

A4 SEF - S S S S S S - -

A4 LEF - S S S S - - S S

Letter SEF - S S S S S S - -

Letter LEF - S S S S - - S S

8.5x13 SEF - S S S S S S - -

Legal SEF - S S S S S S - -

B4 SEF - S S S S S S - -

A3 SEF - S S S S S S - -

11x17 SEF - S S S S S S - -

Letter
Cover LEF

- S S S S - - S S

A4 Cover LEF - S S S S - - S S
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For 2 Hole Punch:

S = Stapling supported
P = Punch supported in positions shown (l = left, r = right, t = top)
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S, P(l) S, P(r) - -

A4 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

A4 LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

8.5x13 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Legal SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

B4 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

A3 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

11x17 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter Cover 
LEF

P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

A4 Cover LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S,P(t) S

A4 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

A4 LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

Letter SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

Letter LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

8.5x13 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

Legal SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

B4 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

A3 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

11x17 SEF P(l,r) S, P(l) S, P(r) S,P(l) S,P(r) S,P(l) S, P(r) - -

Letter Cover 
LEF

P(t) S, P(t) S, P(t) S S - - S,P(t) S

A4 Cover LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S
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For 3 Hole Punch:

S = Stapling supported
P = Punch supported in positions shown (l = left, r = right, t = top)
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S, P(l) S, P(r) - -

A4 SEF - S S S S - - S S

A4 LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter SEF - S S S S - - S S

Letter LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

8.5x13 SEF - S S S S - - S S

Legal SEF - S S S S - - S S

B4 SEF P(t) S S S S - - S, P(t) S

A3 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

11x17 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter Cover 
LEF

P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

A4 Cover LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S,P(t) S

A4 SEF - S S S S S S - -

A4 LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

Letter SEF - S S S S S S - -

Letter LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

8.5x13 SEF - S S S S S S - -

Legal SEF - S S S S S S - -

B4 SEF P(l,r) S S S S S,P(l) S,P(r) - -

A3 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

11x17 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter Cover 
LEF

P(t) S, P(t) S, P(t) S S - - S,P(t) S

A4 Cover LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S
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For 4 Hole Punch:

S = Stapling supported
P = Punch supported in positions shown (l = left, r = right, t = top)
- = Not supported

Page Size Stapler Mode

None Upper 
Left

Upper 
Right

Lower 
Left

Lower 
Right

Two 
Left

Two 
Right

Two 
Top

Two 
Bottom

Po
rt

ra
it

B5 LEF - S S S S S S - -

A4 SEF - S S S S - - S S

A4 LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter SEF - S S S S - - S S

Letter LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

8.5x13 SEF - S S S S - - S S

Legal SEF - S S S S - - S S

B4 SEF - P(t) - - - - - - -

A3 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

11x17 SEF P(t) S, P(t) S, P(t) S S - - S, P(t) S

Letter Cover 
LEF

P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

A4 Cover LEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

La
nd

sc
ap

e

B5 LEF - S S S S - - S S

A4 SEF - S S S S S S - -

A4 LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

Letter SEF - S S S S S S - -

Letter LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S

8.5x13 SEF - S S S S S S - -

Legal SEF - S S S S S S - -

B4 SEF P(l.r) - - - - - - - -

A3 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

11x17 SEF P(l,r) S, P(l) S, P(r) S, P(l) S, P(r) S, P(l) S, P(r) - -

Letter Cover 
LEF

P(t) S, P(t) S, P(t) S S - - S,P(t) S

A4 Cover LEF P(t) S, P(t) S, P(t) S S - - S,P(t) S
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Scanning TWAIN plug-in does not support mixed page size jobs

The Remote Scan TWAIN plug-in does not support transferring mixed original size scan 
jobs to applications such as Adobe Photoshop. However, the Remote Scan application does 
support retrieving mixed scan jobs from mailboxes and distributing these jobs through e-mail 
or saving them to a local hard disk drive. 

Initiating a scan job

Initiating a scan job remotely is not supported. You can, however, retrieve and distribute scan 
jobs. To initiate a scan, you must use the interface on the copier.

Cannot change Mailbox/Job Template Name in Edit Mode

When you select Edit mode for an existing Mailbox/Job Template on the copier, you cannot 
change the name of the Mailbox/Job Template, but you can change any of the Mailbox/Job 
Template settings, such as Color Mode or Scan Size.

Duplex scanning

The Remote Scan application and TWAIN plug-in provide an option to select double-sided 
or single-sided to retrieve a scan. This option does not have any effect. The Mailbox/Job 
Template used for the scan job specifies whether the scan is double-sided or single-sided.

Supported applications

The following applications support the TWAIN plug-in: Adobe Photoshop versions 5.5 and 
6.0 for Mac OS and Windows, and Adobe Acrobat version 6.0 for Mac OS and Windows.

Acrobat 7.0 not supported

The Remote Scan TWAIN plug-in is supported in Acrobat 6.0, but not in Acrobat 7.0. 
You can also use Remote Scan and WebScan to retrieve scans.

Default Mailboxes/Job Templates

The following default Mailboxes/Job Templates are predefined on the copier: (ColorCal), 
(InternetFax), (color), (bw), (grayscale).

Mailbox/Job Template naming

When you retrieve a scan using Remote Scan or WebScan, for the default templates (color), 
(bw), and (grayscale), enter 0 as the mailbox name. For the (InternetFax) template, enter 
InternetFax as the mailbox name. Default templates have no passwords (leave blank).

When you create a Mailbox/Job Template, use only uppercase letters (A-Z) and numerals
(0-9). When you retrieve a scan using a user-defined template, enter the name, using only 
uppercase letters and numerals. If you enter the name using lowercase letters, you can log on 
to the mailbox, but cannot view any scan jobs. 
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Mailbox/Job Template display order

User-defined templates are listed in ASCII order. The default templates are always listed 
before any user-defined templates.

Scan to FTP not supported for all FTP servers

Scan to FTP is not supported for all FTP servers. If an FTP server does not reply to a NLST 
command with a 4xx or 5xx response, scan to FTP from the Fiery EXP250 does not work 
correctly. The WS_FTP server is known to have this issue.

Check Scanner message

If a message appears in Command WorkStation that says to “check scanner power and cable,” 
check the link light on the crossover cable connecting the Fiery EXP250 to the copier. If it is 
not lit (green), try replacing the cable.

Supported formats

The following table shows the supported formats for scanning:

Scan Color Mode

Color Grayscale Black-and-White

JPEG Single Page Supported Supported Not supported

Entire Job Not supported in 
WebScan. In Remote 
Scan, you can generate 
multiple JPEG files, 
each of a single page.

Not supported in 
WebScan. In Remote 
Scan, you can generate 
multiple JPEG files, 
each of a single page.

Not supported

TIFF Single Page Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file 
format, but only 
shows one page.

Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file 
format, but only 
shows one page.

Supported

Entire Job Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file 
format, but only 
shows one page.

Generates TIFF files 
that can be opened by 
Microsoft Office 2003 
(Microsoft Office 
Document Imaging). 
Photoshop 6 or above 
can open this file format, 
but only shows one 
page.

Generates a single 
multiple page TIFF file.

PDF Single Page Supported Supported Supported

Entire Job Generates a single 
multiple page PDF file.

Generates a single 
multiple page PDF file.

Generates a single 
multiple page PDF file.



Page 29

Part Number: 45048062

If you create a mailbox with Output Color/Original Type set to Black (Text), Black (Photo), 
or Black (Text & Photo), you cannot save any scans to this mailbox in JPEG format. You can 
only save them in TIFF or PDF format.

No Initiate tab in Remote Scan

The online help for Remote Scan describes an Initiate tab that does not exist in this version. 
You can initiate scan jobs from the copier, not from Remote Scan.

WebTools Exiting WebTools

Closing the window for an individual WebTool does not exit the browser. To exit WebTools 
completely, close the WebTools window and your browser.

Server name on Mac OS X

In WebTools on Mac OS X, if you click the Configure button, the server name disappears 
from the left side of the screen. If you then click Cancel, the server name reappears.

Command 
WorkStation

Job Size

Command WorkStation displays job size in kilobytes, regardless of the size of the file. 
Other tools may show job size in megabytes or kilobytes.

Activity Monitor

When you print more than one copy of a job, the Activity Monitor reports that Copy 2 is 
printing, and then Copy 2, Copy 3, Copy 4, and so on. Although the Activity Monitor 
does not start counting with Copy 1, the correct number of copies prints.

Available memory

The General Info section displays the amount of memory available for Command 
WorkStation and other Fiery software, whereas the Configuration page displays the amount 
of memory available for Command WorkStation, other Fiery software, and the Fiery system 
software.

The “Memory 100%” displayed in the upper-right corner of the copier display is the 
copier memory. The memory bar in Command WorkStation is the Fiery EXP250 memory.

Combine Separations

If you send a job with Combine Separations set to On, you may see an error message in 
Command WorkStation. To avoid the error message, set Combine Separations to 
Printer’s default or Off, or send a Separations job.
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File formats for downloading

You can import or download only files of the following formats to the Fiery EXP250 using 
Command WorkStation, Downloader, or WebDownloader: PostScript (PS), EPS, TIFF, PDF, 
PCL, PJL, and text. Downloading files of unsupported formats results in an error message or 
an unusable printout.

Using Windows shortcuts

On Windows, if you have a shortcut that does not resolve (cannot be authenticated), you 
cannot browse to files from Command WorkStation using that shortcut.

Incorrect display for Adobe FrameMaker jobs

When you print a job with multiple copies from FrameMaker, the number of copies shown in 
Command WorkStation on Windows platforms is incorrectly displayed as 1.

Page size for printing job properties

If you print job properties from Command WorkStation, the job properties print on the 
default page size set in the printer driver, not the default page size of the copier.

Printing job properties for PCL jobs

To print the job properties for a job sent using the PCL printer driver, set the Job Properties 
format under Preferences to Driver Overrides Format instead of Simple Table Style Format.

Recovering jobs after server interruption

If the Fiery EXP250 is shut down, any job in the Print queue that has been RIPped but not 
printed is sent to the Hold queue. Any job that has not yet been RIPped remains in the Print 
queue.

Profile selections not updated on Mac OS X

On Mac OS X, if you download a profile using ColorWise Pro Tools, the new profile will not 
appear as a selection in the job properties in Command WorkStation, Macintosh Edition 
unless you quit and restart Command WorkStation, Macintosh Edition. Alternatively, you 
can use Command WorkStation on Windows to select the new profile, because on Windows, 
Command WorkStation uses Two-Way Communication to get the new profile setting.

Menu selections incorrectly enabled for processing job

In Command WorkStation, Macintosh Edition, you can select Print and Hold or Print for a 
job that is already being processed. These menu selections should be disabled.
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Merging jobs with duplex printing

In Spooler, if you merge two jobs that have duplex printing, the orientation of each page 
in the job cannot be changed because you are merging the raster data. However, the page 
orientation that is correct for the individual jobs may not be correct for the merged job. 
You might need to reorient one or more pages before merging the jobs. 

If the jobs use an LEF page size and you want the merged job to print Top-Top, make sure 
that both the original jobs are printed Top-Top. If the jobs use an SEF page size and you want 
the merged job to print Top-Top, set Top-Top in both jobs and set the Rotate 180 option for 
the second job.

Cannot merge jobs with different duplex settings

You cannot merge a duplex job with a single-sided job. The jobs must both be duplex or 
single-sided.

Job Log

Save and clear the Job Log regularly. After the Job Log accumulates a large number of 
entries (approximately 16,000 jobs), the Fiery stops responding when you start Command 
WorkStation.

Job Log page count incorrect

If you insert a blank page in a job using Preview, the blank page is included in the page count 
shown in Job Log. If you insert a blank page using Mixed Media, the page count is correct 
(blank pages are not included).

Printed Copies in Job Log

In the printed Job Log, the numbers under Printed Copies (in the Originals, Color, B&W, 
and Total columns) refer to the number of pages in each job, not the number of copies.

Job Log Records Limit

In Command WorkStation Preferences, if you enter 999999999 as the Records Limit under 
Job Log, there is a beep but no error message. The maximum value allowed is 99999.

Scale option constraints

If you view Job Properties using Simple Table Style Format, you can enter invalid values for 
the Scale option, which has a minimum value of 25% and a maximum of 400%. If you view 
Job Properties using the Driver Overrides Format, you are prevented from entering values that 
are less than the minimum or greater than the maximum.
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Image Shift option constraints

If you view Job Properties using Simple Table Style Format, you can enter invalid values for 
the Image Shift X and Y values, which both have a maximum value of 999.99 points, 13.88 
inches, or 352.77 mm. If you view Job Properties using the Driver Overrides Format, you are 
prevented from entering values that are greater than the maximum.

Image Shift units in Job Properties

When the Job Properties format is set to Simple Table Style Format, you cannot select the 
units for the Image Shift settings. The units are always 1/100 of a point. To select the units 
(mm, inches or points), change the Job Properties format (in Preferences) to Driver Overrides 
Format.

Fractional inputs in Print Pages 

The Print Pages dialog box allows you to enter a fractional (non-integer) value for the number 
of copies. If the value is greater than 1, the integer portion of the number is used. If the value 
is less than 1, an error message appears, and you must click OK twice to dismiss the message.

Find dialog box

In Command WorkStation, the Find dialog box includes fields for Notes 1 and Notes 2. Print 
jobs have only a Notes field, however.

Surface count in Impose

In Impose, if you make a change in the layout that reduces the page count (for example, 
changing from 1-up to 2-up) the surface count (in the lower left) is not updated, although the 
page count is. Scrolling, resizing the screen, or selecting another surface updates the count.

Operator access privileges

In Command WorkStation, Windows Edition Help and Command WorkStation, Macintosh 
Edition Help, access privileges for the operator are described incorrectly. 

The operator has access to all Command WorkStation functions except accessing server setup, 
deleting the Job Log, and changing password setup. The functions with operator access 
include aligning trays, rebooting and restarting the server, clearing the server (except for the 
Job Log), printing information pages, and font management.

No Preview on Mac OS

You cannot preview a job in Command WorkStation, Macintosh Edition. This feature 
requires the Impose application, which is not supported on Mac OS computers.

Mixed Media and Tab Printing not supported for landscape jobs

The Mixed Media and Tab Printing features are not supported for jobs with a Landscape 
orientation. Only Portrait jobs can use these features.
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Hot Folders Features not available on Mac OS X

Hot Folders on Mac OS X does not retrieve information from the Fiery EXP250, therefore 
some features available in Hot Folders on Windows are not available on Mac OS X. Create 
Master and Use Master files that are on the server are not available. Information about the 
installable options and the print options that depend on them is not available. The pictures 
of the printer and the logo that appear in the Windows Hot Folders are not available.

Page range (Mac OS X)

In Hot Folders on Mac OS X, you cannot enter a page range in the job properties. Entering a 
page range is supported in Hot Folders on Windows.

Conflict message (Mac OS X)

In Hot Folders on Mac OS X, if you enter a setting in job properties that requires a finisher 
when no finisher is installed on the copier, a conflict message appears that allows you to 
change the configuration of the printer driver to include a finisher. However, do not make this 
change if there is no finisher installed. The printer driver configuration must always agree with 
the actual copier configuration.

Downloader and 
WebDownloader

Downloading PDF or TIFF files

WebDownloader and Downloader do not support sending a PDF or TIFF file to the Direct 
connection. The file is sent to the Print queue instead, or to the Hold queue if the Print queue 
is not enabled.

Downloading fonts

Before downloading fonts, clear the Member Printing option.

Drag and drop

When you use the drag-and-drop method to print a file, Downloader functions slightly 
differently on Mac OS than it does on Windows. On Mac OS, when a file is dropped onto 
the Downloader icon, the Status window appears and remains displayed, even after the file is 
printed. On Windows, the Status window appears and then closes when the job finishes 
printing.
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Adding files

In the Files to be Downloaded dialog box, you must either double-click the file or highlight 
the file and click Add Files. You cannot drop a file onto the Files to be Downloaded 
dialog box.

If an error occurs when adding a file to the download list, try the following:

• Make sure the file is closed. A file that is open for viewing cannot be added to the 
download list.

• If you are using Windows, start Windows Explorer and choose Folder Options from 
the Tools menu. Click the View tab, clear the “Hide file extensions for known file types” 
option, and then click OK.

File formats

Downloader supports only EPS, PDF (version 1.5 and earlier), or PS formats for printing to 
the Fiery EXP250.

Downloading PDF files with mixed page sizes or orientations

When you download PDF files that contain more than one page size or orientation, the file 
may not print correctly. To print the file, open it in Adobe Acrobat and print using the printer 
driver.

Downloading 16-bit TIFF Files

Downloader is unable to download 16-bit TIFF files to the Fiery EXP250.

File types

When you browse files from WebDownloader, the default file name extension is “.html”. 
WebDownloader does not determine the default file type or the file type listed in the File 
dialog box. The default file type is predefined by your Internet browser. However, if you send 
html files to the printer, the data is printed as ASCII text (the default extension for ASCII text 
is “.txt”). Choose All Files from the Files of type menu to view other files to download.

When you download PDF files from a Windows computer, the file name and user name are 
displayed as “Unknown.”

Device Name

In Downloader, the Device Name field in the Add New Server does not need to be the valid 
device name. You can connect to the server as long as the Server Name is valid.

Server connection via Appletalk

If Downloader is connected to the Fiery EXP250 via Appletalk and the Fiery EXP250 is 
restarted or rebooted, Downloader stops responding.
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ColorWise Pro Tools Color defaults

To set defaults for color printing options, use Color Setup in ColorWise Pro Tools. 
The exception is Color Mode, which cannot be set in Color Setup, nor in Setup from 
Command WorkStation or WebSetup. However, you can set the color mode for a job at print 
time when you print from the printer driver.

ColorCal

Make sure that the Original Orientation option on the copier is set to Head to Top and that 
the ColorCal patch pages are positioned Head to Top on the copier platen.

When you print measurement pages for ColorCal, an instruction page also prints. To ensure 
good results after calibration, follow these instructions.

NOTE: There is currently no way to print only the measurement pages without the instruction 
page.

Calibrating before Start Page is printed 

Allow the Start Page print before performing calibration. This ensures that the Fiery EXP250 
has fully completed its startup process.

Profile Manager not supported on Mac OS 9

In ColorWise Pro Tools on Mac OS 9, the Profile Manager is not supported.

Applications Adobe PageMaker and Booklet Maker

The Booklet Maker option is not supported for printing from PageMaker.

Microsoft Excel and PCL printer driver

If you print from Excel using the PCL printer driver, and the document contains bold 
characters in a font that does not have a separately defined bold font, set the following options 
in the PCL printer driver on the Fonts tab: 

• Select Auto Match

• Select Outlines under Font downloading

Microsoft Excel and multiple copies

If you print multiple copies of a file from Excel, all the pages are combined into a single copy. 
If the job is stapled, all the pages are stapled together, and if the job is printed as a booklet, all 
the pages are combined into one booklet. If duplex printing is enabled, the first page of one 
copy might print on the back side of the last page of the previous copy.

To print multiple copies from Excel, print to a file, and then download the file using 
Downloader or Command WorkStation.
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If you want collated copies, you must clear the Collate option in Excel (in the Print dialog 
box) and select the Collate option in the Fiery Printing tab.

Visio 2003 and PCL printer driver

If you print from Visio 2003 using the PCL printer driver, select the “Always use host fonts” 
option on the Fonts tab of the printer driver.

Adobe Freehand

To print from Freehand on Windows, use the PostScript printer driver rather than the PCL 
printer driver.

Collation

To collate a job when you print from Microsoft Word, do not set the Collate option in the 
Print dialog box. Instead, set the Collate option on the Fiery Printing tab.

To collate a job when you print from CorelDRAW or Microsoft Internet Explorer version 
5 or 5.5, use the Collate option in the printer driver in addition to the Collate option within 
the application.

Landscape duplex

When you print a landscape job as duplex, some applications, such as Adobe PageMaker 
and Adobe Acrobat 4, produce Top-Top output when you select Top-Bottom, and vice versa. 
For Acrobat 5 jobs, select the Auto Rotation option for duplex printing.

Booklet printing in Microsoft Word

If you print a document as a booklet from Word, you must set the page size in the application 
(in Page Setup) and the page size in the Fiery Printing tab to the same setting. For more 
information, see “Printing a booklet from Microsoft Word on Windows (PostScript printer 
driver)” on page 13.

Printing to a custom page size in Microsoft Word

Use the following procedures to print to a custom page size from Microsoft Word 2000, 
2002, XP, or 2003 using the Windows PostScript printer driver. Specify the custom page size 
in one of two ways: using forms or not using forms.

TO PRINT TO A CUSTOM PAGE SIZE USING FORMS

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start, and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Click the Fiery EXP250 icon and choose Server Properties from the File menu.

The Print Server Properties window appears.

3 On the Forms tab, select the Create a New Form option.
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4 Under Measurements, enter the Width and Height of the custom page size.

5 Next to Form Description for, enter a name for the form that indicates the page size.

6 Click Save Form and click OK.

7 Open the document to be printed in Microsoft Word.

8 Choose Page Setup from the File menu and click the Paper Size tab.

9 Choose Custom size from the Paper size drop-down list.

Do not select the form you created.

10 Enter the same Width and Height values that you used to create the form and click OK.

11 Choose Print from the File menu.

12 Select the Fiery EXP250 as the printer and click Properties.

13 Click the Paper/Quality tab and click Advanced.

14 Next to Paper Size, select the form that you created and click OK.

15 Click the Fiery Printing tab and check that the Page Size setting (under the Paper Source bar) 
is set to the custom page size.

16 Select the Paper Source.

17 Click OK to close the Properties window.

18 Click OK to print.

TO PRINT TO A CUSTOM PAGE SIZE WITHOUT USING FORMS

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start, and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Click the Fiery EXP250 icon and choose Printing Preferences from the File menu.

3 Click the Paper/Quality tab and click Advanced.

4 Next to Paper Size, choose PostScript Custom Page Size.

5 Enter the Width and Height values of the custom page size and click OK.

6 Click OK to close the Advanced Options window.

7 Click the Fiery Printing tab, check that the Page Size setting (under the Paper Source bar) is 
set to PostScript Custom Page Size, and click OK.

8 In Microsoft Word, choose Print from the File menu.

9 In the drop-down list next to Scale to Paper Size, select PostScript Custom Page Size.

10 Select the Fiery EXP250 as the printer, and click OK to print the document.
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Microsoft PowerPoint 2003 on Windows 2000

When you print from Microsoft PowerPoint 2003 on Windows 2000, you might see repeated 
images or images that are reduced in one dimension in the printed output. The output prints 
correctly if you print from Windows XP or from PowerPoint 2000.

Mirror print option in Acrobat 6

In Acrobat 6, if you select the Mirror print option, you must also select Print as Image. 

1 Choose File > Print, and then click Advanced.

2 Select Print As Image and any other desired printing options.

3 Click OK to close the Advanced Print Setup dialog box, and then click OK. 

Adobe Acrobat v7.0 not supported

Printing from Adobe Acrobat v7.0 is not supported.

Online help Help files

The help files for the Fiery utilities are developed for use with Microsoft Internet Explorer 
v5.5 and later. If you use a browser such as Safari, or previous versions of Internet Explorer, 
the help might not display properly.

With Microsoft Internet Explorer on a Windows XP Service Pack 2 computer, the help files 
might not display or display properly in the following situations:

• If your browser uses a pop-up blocker, it might block the help files. If this happens, 
temporarily disable your pop-up blocker to display the help file.

• If your browser has the advanced Internet option enabled to display notifications about 
script errors, it might display a warning window before displaying a help file page. To avoid 
the warning window, clear the “Display a notification about every script error” option in 
the Advanced tab in the Internet Options dialog box.

• A warning message might also appear in the Status bar, but the content of the help file is 
not affected by this error.
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